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Chapter 1: The Alarm List
1.1 Introducing the Alarm List
Process alarms and 'IGSS Alarm'
IGSS Alarm is a fast and powerful alarm handling routine which is an integral part of the IGSS process control system. This is an enormous advantage to both the plant operator and the system designer as all interfacing between alarm management and process supervision and control functions is dealt with
automatically by IGSS.
Your plant signals an alarm situation whenever the control process generates an error which may be some
electrical equipment not functioning properly, or some measured values stepping out of the predefined limits. Thus it could for instance happen that the water level of a tank level rises dangerously high or a valve
did not close properly where it should have done. In all these cases, alarm signals of higher or lesser importance are registered by IGSS and indicated to the operator in various ways:
l

The alarm counter, which is a special icon displayed on the screen in the taskbar or in a userdefined spot, is automatically incremented with each new alarm and thus indicates the number of
unacknowledged alarms.

l

The symbol in the process screen which represents the faulty plant component changes color or
begins to flash.

l

A text message explaining the nature of the alarm appears in the message line of the currently displayed process screen.

l

The alarm and all its relevant information is recorded in two lists
l

the Active Alarms

l

the Alarm Log

for evaluation, archiving, reporting and further processing.
l

Depending on its severity, the alarm may be announced by an acoustic signal and service personnel may be called over the paging system.

Below the Alarm List, you will find the Event List. Click here for further information.

How is an alarm identified ?
A process alarm is primarily identified by its alarm number .
Each alarm number is linked to a specific plant component - an object - and thus indicates that this particular object is in the state of alarm.
All characteristics of that alarm - priority, color, alarm text, acknowledged or not acknowledged - are
stored under this number.

Alarm characteristics
Apart from the identifying alarm number, each alarm is given a set of attributes which describe nature and
severity of the process alarm:
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l

Priority, from 1 to 255

l

Date and time of alarm occurrence

l

Date and time of alarm end

l

Time of alarm acknowledgement

l

Name of the faulty plant object

l

Name of the plant area to which the object belongs

l

Worst process value measured for the faulty plant object

l

Node (PLC) and driver identification

l

Name of the user who has acknowledged the alarm

These details are automatically recorded in both the alarm list and the alarm log.

The Alarm Count icon

The Alarm Count icon is a special icon that can be displayed on the local machine when the alarm
module is started. The Alarm Count icon provides the operator a quick overview of the alarms in the
system and the operator can access to the Active Alarms form by double-clicking the Alarm Count
icon.
The alarm count icon can be set up to display:
l

the number of objects currently in alarm

l

the number of currently active unacknowledged alarms (default setting)

l

the number of acknowledged and unacknowledged alarms

l

the number of alarms that match the used alarm filter

Enable and set up

The Alarm Count icon can be enabled in the Active Alarms form > View > Alarm Count. Display
parameters for the Alarm Count icon can be defined in the System Configuration form > Alarm tab
> Counter group found in the IGSS Master > Design and Setup tab.
The alarm icon automatically adopts the color of the pending alarm with the highest priority so that you are
always informed about the severity of the alarms still awaiting acknowledgement and correction.
Alarm count icon placement

Taskbar
The alarm icon is permanently displayed, either in the taskbar in the bottom of the screen, provided that
the taskbar is enabled for your application, or in a predefined spot on the screen, irrespective of which process diagram is currently being displayed.

System tray
The alarm icon is also displayed in the system tray.
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The Alarm List
Click the picture for further information

Active Alarms versus Alarm Log
Every alarm triggered in the plant and defined as such during project design is principally registered in two different generated automatically lists: The ALARM LIST and the ALARM LOG.
These lists provide the operator with important information about the alarm situation.
Active Alarms

Alarm Log

contains all pending alarms, i.e. those alarms that are
currently active.

Contains ALL process alarms,
including those that have been
acknowledged or whose cause
has in the meantime been corrected.

Alarms are automatically deleted from the list when
Alarms are not automatically
the alarm situation has ended AND the alarm has been deleted from the alarm log,
acknowledged. Alarms that are acknowledged but
irrespective of their ‘age’.
whose cause has not yet been eliminated, or alarm situations that have been corrected but not yet acknowledged, remain in the alarm list, i.e. they are
considered as being active or pending.

The alarm list is a subset of the alarm log.

The alarm log contains the
pending alarms registered in
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Active Alarms

Alarm Log

the alarm list AND the ‘old’
alarms.
You may define your own sorting and filter criteria and
thus exactly define which type of alarms you want to
have displayed in the alarm list and in which format
and layout.

You yourself define the period
of time to be covered by the
alarm log. You may for
instance decide to call up an
alarm log that shows all
alarms - acknowledged or not
– from the last 24 hours.

All edit functions offered in the menu bar (filter, sort,
find, note, freeze, delete, update etc.) can be applied
to the alarm list.

All edit functions offered in
the menu bar (filter, sort,
find, note, freeze, delete,
update etc.) can be applied to
the alarm log.

Alarm log display limits

The alarm log will only display alarm log entries if the number of alarm log entries is below the defined maximum number of alarm log entries permitted. If the number of alarm log entries exceeds the maximum, you
must create and apply an alarm filter to display the desired alarm log entries.
The maximum number of alarm log entries permitted is set up in the Max. alarm log entries field on the
Alarm tab of the System Configuration form.

1.2 Viewing the Alarm List
Open the Alarm List or the Alarm Log
You can open the Active Alarms form by clicking the Alarm Count icon (if the alarm count icon is enabled)
or clicking the Alarm button found on the IGSS Master > Home tab.
Interpret the contents of the list
The complete alarm list and alarm log provide the following information about the process alarm:
l

S.No. = Sequence Number

l

Start Date

l

Start Time

l

Acknowledge Time

l

End Time

l

Object Name

l

Worst Value

l

Alarm Text

l

Area Name

l

Object Description

l

Value

l

Priority
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l

Alarm Number

l

Acknowledge Date

l

End Date

l

Alarm State

l

Driver Id.

l

Node Id.

l

User name

l

Arrival date

l

Arrival time

l

The icons

l

You can adjust the information displayed or printed in the alarm list or log according to your own requirements. Not all of
the above details need to be included in the list.

See also

1.3 Predefined System Alarms
List of predefined alarms
The alarm numbers between 1 and 100 have been reserved for reporting system alarms in IGSS. System
alarms are used for generating warnings to assist in controlling and troubleshooting IGSS. When activated,
these alarms will appear in the Active Alarms form.

Do not delete or re-use the predefined alarms for alarm indication purposes
in your objects in your configuration. These alarms are used for reporting
specific system events.
To view a complete list of all alarms in the configuration - system alarms as well as user-created alarms, in
the Supervise module, click Tools > Alarms to open the Alarm Details form.

Alarm See-Thru and Communication errors
Alarm number 1 is used for alarm See-Thru and the alarm numbers between 10 and 51 are reserved for various communication errors (the communication ports, the PLC, the data collection engine, etc.).

Alarm
Number

1

Description

An object on the diagram a button is linking to is in alarm.

The alarm border surrounding the button will blink in the alarm color. You can edit the blink and the ala
10 and 11 The setup of drivers is erroneous.
20 and 21 Communications ports are faulty.
30 to 39

Extended event-driven communication drivers fail; please refer to driver documentation.

40

A general PLC error has occurred. Refer to PLC documentation.

41 to 45

Driver communication errors. Refer to driver documentation.
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Alarm
Number

Description

46

Connection to the PLC program is missing. The physical connection may be in order, but for some reas
received the expected "I'm alive" message.

47

Extended event-driven communication drivers fail. Refer to driver documentation.

50

Incomprehensible data from the PLC is received by the data collection engine (DC).

51

Too much data output is generated, for example, if a DDE link generates too much data.

Errors and messages related to other system parameters
The alarm numbers between 80 and 100 are reserved for alarms related to system conditions and errors.

Alarm
Number

Description

80

A network connection to the station type AB-server is lost.

87

This alarm is used when the Data Collector encounters an unexpected error. The alarm text is "Interna

The Data Collector will attempt to recover and if no more errors occur the alarm will be ended. If the D
not recover, the Data Collector will be terminated and restarted by the IGSS Master. When this alarm
basic system health should be checked (data collection and logging working as expected)

You can define Data Collector recover and re-start options in the Alarms on Internal Errors and su
group on the Data Collection tab in the System Configuration form.
88

Logging of LOG, BCL and alarms to disk is stopped for any reason. Any error writing to the LOG, BCL a
or any error accessing the Report folder will also trigger this alarm.
The alarm text is "Data logging has stopped".
The alarm is automatically ended when the conditions triggering the alarm no longer are present.

You can negate this alarm from being triggered by clearing the Generate alarm no. 88 if writing o
has been stopped check box on the Data Collection tab in the System Configuration form.
90

An alarm has been generated by an Event.

91

An operator has attached an alarm inhibit flag to all the alarms defined for the given object.

92

An operator has attached an alarm inhibit flag for specific alarms defined for a given object.

93

An operator has attached a Notifier alarm inhibit flag for all alarms defined for a given object.

94

The current disk usage exceeds the High Limit value of the predefined System object. The default valu

95

The current disk usage exceeds the High Alarm value of the predefined System object. The default val
All writing to the harddisk is suspended when this alarm occurs and log files (*.log) or base class files
be saved.

96

An operator writes a comment on the Object note tab of an object.

97

An alarm normally sent out to the WinPager module has been temporarily disabled.

98

An Event has been generated in the Event list.

99

An undetermined alarm has been received on the IGSSserver. This alarm is used when IGSS receives
that it is unable to find a matching alarm text for. This situation could arise if an alarm text was modifi
lation of the configuration.

100

(reserved for future use by the system)
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See Also

"Driver error codes in the Alarm List" on page 14

Driver Communication Errors
Driver error codes in the Alarm List
Viewing error codes

A driver communication error will result in an alarm in the Alarm List. The alarm number will be one of the
predefined alarm numbers for driver errors and the alarm text will be the general alarm text associated with
that number. The driver error code itself is shown in the Worst Value field. Its syntax is described below.
Help on error codes

If you get a driver error, right-click the alarm line and choose Driver Error Help.
To view the full list of driver-specific error codes, choose Driver Help.
Error code syntax

A driver error code consists of three or four elements separated by periods. The first three elements are
always present, whereas the fourth element is an extended error code which may be omitted depending on
whether IGSS has registered the extended error code from the PLC manufacturer.
The error code convention is as follows:
<Drv No>.<Node No>.<IGSS error code>.<Extended error code>
where:
Syntax

Description

Format

Example

<Drv No>

The number of the driver used.
You can find the driver ID in the ID column
of the Select Communication Driver
dialog or on the Driver Information tab
for the selected driver.

Decimal

19
(Telemechanique
Xway
protocol driver 7TXWAY)

<Node
No>

The node number assigned to the PLC in the
System Configuration form.

Decimal

05
for node number
5

<IGSS
error
code>

The IGSS error code

Hexadecimal

130A

<Extended
error
code>

Is the extended error code which typically
Hexadecimal
comes from the PLC or the PLC interface software

0c02
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The full error code in the Worst value field would thus be 19.05.130A.0c02.
See Also

"Extended Error Codes" on page 15
"List of general driver error codes" on page 15
Extended Error Codes
Extended error codes originate from the PLC interface software or from the Windows operating system and
are displayed in the Active Alarms form as the fourth (and last) element of the driver error code.
Error code descriptions

The link below contains the error code descriptions received from the PLC manufacturers. In some cases,
the extended error code may be missing if information concerning the error code has not been imparted.
For further details about these error codes, refer to the documentation from the PLC manufacturer.
Windows error codes

In some cases, the extended error code is a Windows error code. A Windows error code is generated by the
WIN32 API and is registered by the IGSS communications driver.
See Also

"List of general driver error codes" on page 15
"Driver error codes in the Alarm List" on page 14
List of general driver error codes
IGSS includes a number of predefined alarms used for reporting general driver communication errors in the
Active Alarms form. The alarms will be reported on the predefined driver communication object named
Driver or the relevant node status object, if defined.
The communication errors can also be viewed in the Communications tab in the IGSS Master as shown
below.
Alarm
number

Alarm text

Communications error
text

10

Global driver configuration error

CONFIGERR

11

Global driver resource problem

DRVRESRC

12

Servers def time not the same

DEFTIMEERROR

20

Errors occurred during input fm
port

LOWLEVERRI
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Alarm
number

Communications error
text

Alarm text

21

Errors occurred while output to
port

LOWLEVERRO

22

Errors reported by GetLastError()
in

IOERRORI

23

Errors reported by GetLastError()
out

IOERRORO

24

Errors reported by ClearCommError() in

COMMERRORI

25

Errors reported by ClearCommError() in

COMMERRORO

40

In remote PLC reported by protocol

PLCSYSERR

41

Message protocol errors while
input

PROTOCERRI

42

Message protocol errors while output

PROTOCERRO

43

Packet level error during input

PACKETERRI

44

Packet level error during output

PACKETERRO

45

A bad packet received and
returned

BADPACKET

46

Keep alive timeout

KPALV_TO

47

Errors from dialup module

DIALUPERR

48

DCA-TCP: Error group for remote
DCA's

DCATCPERR

49

Error codes received from AlarmNet

ALARMNETERR

50

Errors generated by DC at packet
in

DCPACKETI

51

Errors generated by DC at packet
out

DCPACKETO
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The error code itself is shown in the Worst value field of the Active Alarms form. The Error description field in the table describes the cause of the error and suggests corrective action.
Worst
value1

Error Description

Internal error
text

0x0040

No buffer or request blocks

NO_REQBUF

0x0041

No scan buffers

NO_MSGBUF

0x0042

Ring buffer is full (B.060)

RBUF_FULL

0x0042

Received buffer does not match scan record

SREC_ERR

0x0044

Received buffer has unexpected length

LEN_ERR

0x0045

No channel exists for requested node

NO_CHAN

0x0046

Unexpected character received

CHAR_ERR

0x0047

Wrong BCC/FRC/CRC code in telegram

CRC_ERR

0x0048

Unsupported data type

TYPE_ERR

0x0049

Unsupported data group

DB_ERR

0x004A

Unsupported offset

OFFSET_ERR

0x004B

Transmit waiting for flow control signals (i.e. device off or cable is broken)

TX_FLOWCTRL

0x004C

Node suspended by operator.

ONLINESUSPEND

0x0050

Open timeout

TO_OPEN

0x0051

Connect request timeout

TO_CR

0x0052

Send timeout

TO_XMIT

0x0053

Receive timeout

TO_RECV

0x0001

Cause: An event telegram was received with an invalid type value
Action: Check the PLC program that sends the telegrams

DC_INVTYPE

0x0002

Cause: An event telegram was received with a length that is shorter then
allowed
Action: Check the PLC program that sends the telegrams

DC_BADLEN

0x0004

Cause: An event telegram was received with a type message code that is not
supported by DC
Action: Check the PLC program that sends the telegrams

DC_NOSUPPORT

0x0005

Cause: An event telegram was received with a type message code that is not
supported by DC as an inbound packet
Action: Check the PLC program that sends the telegrams

DC_NOTINPKT

0x0006

Cause: An event telegram was received with an object address that is not in
the configuration
Action: Check the PLC program that sends the telegrams

DC_INVADDR
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Worst
value1

Error Description

Internal error
text

0x00e1

Cause: An event telegram was received with a bad type value.
Action: Check the PLC program that sends the telegrams

_7TPOLLED_BADTYPE

0x00e2

Cause: An event telegram was received with a length that is longer then
allowed
Action: Check the PLC program that sends the telegrams

_7TPOLLED_
BADWLEN

0x00e3

Cause: An event telegram was received with a wrong timestamp or an
address request with wrong type.
Action: Check the PLC program that sends the telegrams

_7TPOLLED_BADCONT

0x00e4

Cause: A time synchronization telegram was received from a node that is not
time master.
Action: Correct the problem in the System Configuration form.

_7TPOLLED_
BADTSYNCH

0x00e5

Cause: Invalid Minor State
Action: Internal error

_7TPOLLED_
DIALUP_MINORSTATE_ERROR

0x00e6

Cause: Unable to establish call
Action: Check modem and phone line

_7TPOLLED_
DIALUP_CONNECT_TIMEOUT

0x00e7

Cause: Driver can't find node to call
Action: Check that node definition in System Configuration form and the Definition modules match.

_7TPOLLED_
DIALUP_NODE_
UNDEFINED

0x00e8

Cause: Can't perform a proper disconnect
Action: Check modem

_7TPOLLED_
DIALUP_DISCONNECT_TIMEOUT

0x00e9

Cause: No valid response to historical data request
Action: Check quality of phone line.

_7TPOLLED_
DIALUP_HISTDATA_TIMEOUT

0x00ea

Cause: Timeout reading valid node number in calling PLC.
Action: Check that correct node number is written into the right PLC address.
Remember to write node number in SATTR16 if COMLI protocol. Check for correct Data Group and Word Offset in the System Configuration form >
Modem > Remote.

_7TPOLLED_
DIALUP_PREEVENT_TIMEOUT

0x00eb

Cause: Phone connection disconnected by remote party.
Action: Re-establish connection manually.

_7TPOLLED_
DIALUP_GOT_
DISCONNECTED

0x00ec

Cause:IGSS could not read a valid node number in the calling PLC.
Action: Make a scanned analog object that addresses the location in the PLC
where you expect to find the node number. Call the PLC from IGSS and verify
that the node number is correct.

_7TPOLLED_
DIALUP_ILLEGAL_NODE_NO
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Worst
value1

Error Description

Internal error
text

0x00ed

Cause: Unable to establish call to PLC.
Action: Check phone number, modem and cable.

_7TPOLLED_
DIALUP_CONNECT_FAILED

0x00ee

Cause: Timeout writing scan complete indication to the PLC
Action: Check for correct Data Group and Word Offset and value in the System Configuration form > Modem > Remote

_7TPOLLED_
DIALUP_POSTEVENT_TIMEOUT

0x00ef

Cause: Too long outbound message.
Action: Check for correct segment size in System Configuration form.

_7TPOLLED_OUTBOUND_LEN_
ERR

0x00f0

Cause: Too long outbound mailbox message
Action: Check for correct segment size and mailbox size in the System Configuration form.

_7TPOLLED_MAILBOX_LEN_ERR

0x00f1

Cause: The time interval for collection of historical data was set to zero. The
program modified the interval to 60 seconds.
Action: Setting the interval in the System Configuration form to zero is
only valid if the driver can read actual interval in the PLC.
Correct the interval in System Configuration form > Node > Connection
Misc. > Configure > Interval.

_7TPOLLED_
INVHISTTIME

0x00f2

Cause: There is no dummy node configured for the alarm modem.
Action: Add a node to the alarm modem in the System Configuration form.

_7TPOLLED_NO_
ALARMNODE

0x00d5

Cause: A telegram was received that was too long for the program.
Action: Check that the PLCs are sending valid telegrams, then contact 7T

_7TSICOS_
EBADTLEN

0x00d7

Cause: The link to the node is down.
Action: Check that the PLC is running and that the connection is working

_7TSICOS_ELINKDOWN

0x00d8

Cause: No keep alive telegram was received in the expected time
Action: Check the PLC program

_7TSICOS_
EKPAEXPIR

0x00d9

Cause: A bad sequence number was received
Action: Check the PLC program

_7TSICOS_
EBADRCVSEQNO

0x00da

Cause: No buffer available
Action: Increase number of messages for the driver in the System Configuration form.

_7TSICOS_ENOMOREBUF

0x00dd

Cause: Illegal node number specified.
Action: Remove the object in the IGSS configuration that belong to the illegal
node or create the node in the System Configuration form.

_7TSICOS_EILLEGALNODE

1 in Alarm List and error code in Communications tab in IGSS Master.
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1.4 Acknowledging Alarms
Acknowledge alarms in the alarm list

Procedure

1. In the Alarm List, select the alarm message you wish to acknowledge.
2. In the function menu, select Actions ® Acknowledge.

First Shortcut

1. You are inside the Alarm List.
2. Click on the alarm message which you wish to acknowledge.
3. Click the right mouse button.
4. This opens the Actions function box and places it immediately next to the selected message so that you can now conveniently activate the Ack function.

Second Shortcut

1. You are inside the Alarm List.
2. Click on the alarm message which you wish to acknowledge.
3. Double click on the left mouse button. The alarm is acknowledged.

See also

Acknowledge alarms in the process diagram
You are in the online supervision mode and the symbol of a process object starts flashing, which means it is
in the state of alarm.

Procedure

1. Click on the object that indicates an alarm state.
2. In the menu bar, go Edit ® Acknowledge alarm.
3. The alarm is now acknowledged.

Shortcut
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1. Right-click on the object that indicates an alarm state.
2. A popup menu appears next to the object offering you the Acknowledge command.
3. Click Acknowledge. The alarm is now acknowledged.

See also

1.5 Inhibiting and Removing Alarms
Inhibiting Alarms
You can temporarily inhibit alarms on IGSS objects, preventing specific or all alarms from being sent to the
Active Alarm form until you remove the alarm inhibition again. The present alarm will not be affected and
must be acknowledged and ended as any other alarm. Only new alarms from that object will be inhibited.
Inhibit alarms if the process component is being serviced, renders irrelevant alarms for other reasons or to
prevent additional alarms disturbing work on the component.
If multiple objects share the same alarm number, inhibiting a alarm only inhibits alarms from that particular
object. All other objects can still trigger the same alarm numbers. You cannot inhibit all alarms for all
objects in one process.
You can inhibit alarms for objects directly on the object in the Supervise module or through the Active
Alarms form.
When you inhibit one or more alarms for an object, a system alarm will be generated and displayed in the
Active Alarms form and the Inhibit alarms option in the object menu in the Supervise module will be
displayed with a check mark to indicate that the object contains one or more inhibited alarms.

It is possible to remove operator access to the object menus in Supervise. If this is the case, inhibiting alarms and reactivating inhibited alarms is not possible in the Supervise module.

Inhibit specific alarms
You can inhibit specific alarms for the object either through the Active Alarms form or directly on the
object through the Supervise module.

Inhibit specific alarms in Supervise
To inhibit specific alarms on an object in Supervise:

1. Click the object on the diagram and select Inhibit Alarms to open the Inhibit Alarms form.
2. In the Inhibit Alarms form, select the Inhibit only individual alarms on the object as
selected below check box
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3. If you want to inhibit other alarms not configured for the object, select the Also show alarms
that may be generated from code check box 1.
4. In the group box below the Inhibit only individual alarms on the object as selected
below check box, select the alarms you want to inhibit.
5. Click the OK button to save and close the Inhibit Alarms form.

1 It is possible to create VBA procedures in IGSS which can trigger an alarm for an object, even if the spe-

cific alarm has not been configured for that object. You can inhibit these alarms in the same fashion as
alarms that have been directly configured for the object.

Inhibit specific alarms in the Active Alarms form
To inhibit specific alarms on an object in the Active Alarms form:

1. In the IGSS Master > Home tab, click the Alarm button to open the Active Alarms form.
2. In the right pane of the Active Alarms form, right click the alarm you want to inhibit and select
Inhibit Alarm.

When you inhibit a specific alarm, a new system alarm will be registered in the Active Alarms
form indicating that an alarm has been inhibited. The system alarm number is 92 with the alarm text Alarm
Inhibit (specific alarms). You can acknowledge the system alarm number 92, which will move the alarm to
the Alarm Log.

Inhibit all alarms
You can inhibit all alarms for the object either through the Active Alarms form or directly on the object
through the Supervise module.

Inhibit all alarms on an object in Supervise
To inhibit specific alarms on an object in Supervise:

1. Click the object on the diagram and select Inhibit Alarms to open the Inhibit Alarms form.
2. In the Inhibit Alarms form, select the Inhibit all alarms that have been configured on
this object check box
3. If you want to inhibit other alarms not configured for the object, select the And inhibit individual alarms on the object as selected below check box and the Also show alarms that
may be generated from code check box 1.
1. In the group box below the Inhibit only individual alarms on the object as
selected below check box, select the alarms you want to inhibit. You must also
select any alarms configured on the object.
4. Click the OK button to save and close the Inhibit Alarms form.
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1 It is possible to create VBA procedures in IGSS which can trigger an alarm for an object, even if the spe-

cific alarm has not been configured for that object. You can inhibit these alarms in the same fashion as
alarms that have been directly configured for the object. You can click the Select All button to select all
the alarms displayed in the group box.

Inhibit all alarms on an object in the Active Alarms form
To inhibit specific alarms on an object in the Active Alarms form:

1. In the IGSS Master > Home tab, click the Alarm button to open the Active Alarms form.
2. In the right pane of the Active Alarms form, right click the alarm you want to inhibit and select
Inhibit all Alarms.

When you inhibit a specific alarm, a new system alarm will be registered in the Active Alarms
form indicating that an alarm has been inhibited. The system alarm number is 91 with the alarm text Alarm
Inhibit (All alarms). You can acknowledge the system alarm number 91, which will move the alarm to the
Alarm Log.
See Also

"Reactivating inhibited alarms" on page 23
Inhibit Notifier Alarms
"Remove Notifier Inhibition" on page 26

Reactivating inhibited alarms
You can reactivate specific inhibited alarms or all inhibited alarms for an object, either through the Active
Alarms form or directly on the object in the Supervise module.
When you reactivate inhibited alarms, the Active Alarms form will start registering alarms on the object.
and the system alarm that was generated when the alarms were inhibited will be ended and moved in the
Alarm log with the date and time the inhibited alarms were reactivated registered in the End Date and End
Time fields.

In the Supervise module
Inhibited alarms will always be displayed on the object in the Supervise module and you can inhibit and
reactivate an inhibited alarm directly in the Supervise module.

It is possible to remove operator access to the object menus in Supervise. If this is the case, inhibiting alarms and reactivating inhibited alarms is not possible.

Reactivate a specific inhibited alarm on an object in the Supervise module
To reactivate a specific inhibited alarm on an object in Supervise:
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1. Click the object on the diagram and select Inhibit Alarms to open the Inhibit Alarms form.
2. In the Inhibit Alarms form, In the group box below the Inhibit only individual alarms on
the object as selected below check box, clear the alarms you want to inhibit.
3. Click the OK button to save and close the Inhibit Alarms form.

Reactivate all inhibited alarms on an object in the Supervise module
To reactivate a specific inhibited alarm on an object in Supervise:

1. Click the object on the diagram and select Inhibit Alarms to open the Inhibit Alarms form.
2. In the Inhibit Alarms form, In the group box below the Inhibit only individual alarms on
the object as selected below check box, clear all the alarms to inhibit.
If you select the Do not inhibit any alarms on this object check box, all inhibited alarms
for the object will be reactivated.

3. Click the OK button to save and close the Inhibit Alarms form.

In the Active Alarms form
You can reactivate the inhibited alarm for the object either by reactivating the alarm on which the inhibition
was created or by reactivating the system alarm which was created when the alarm inhibition was created.
If you have acknowledged the system alarm number 91 or system alarm number 92, they are no longer displayed in the Active Alarms form, but are instead displayed in the Alarm Log list.
If you want to reactivate these inhibited alarms for an object through the Active Alarms form, you must
first open the Alarm Log in the left pane of the Active Alarms form, filter the Alarm Log to find the relevant system alarms and then reactivate the inhibited alarm.

Reactivate a specific inhibited alarm for an object in the Active Alarms form
To reactivate a specific inhibited alarm on an object in the Active Alarms form:

1. In the IGSS Master > Home tab, click the Alarm button to open the Active Alarms form.
2. In the right pane of the Active Alarms form, find the alarm number 92 with the alarm text
Alarm Inhibit (specific alarm) for the object you want to reactivate the inhibited alarm for.
You can create a new filter to find all inhibited alarms (Alarm number 92) or you can sort the
Active Alarms form by clicking the Alarm Number or Object Name column heading.

3. Right click the relevant alarm number 92 to open the options menu. The Inhibit Alarm option
is displayed with a check mark.
4. Select the Inhibit Alarm to clear the check mark and reactivate the inhibited alarm.

Reactivate all inhibited alarms for an object in the Active Alarms form.
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To reactivate all inhibited alarms on an object in the Active Alarms form:

1. In the IGSS Master > Home tab, click the Alarm button to open the Active Alarms form.
2. In the right pane of the Active Alarms form, find the alarm number 91 with the alarm text
Alarm Inhibit (all alarms) for the object you want to reactivate the inhibited alarm for.
You can create a new filter to find all inhibited alarms (Alarm number 91) or you can sort the
Active Alarms form by clicking the Alarm Number or Object Name column heading.

3. Right click the relevant alarm number 91 to open the options menu. The Inhibit All option is displayed with a check mark.
4. Select the Inhibit All to clear the check mark and reactivate the inhibited alarm.

See Also

"Inhibiting Alarms" on page 21
Inhibit Notifier Alarms
"Remove Notifier Inhibition" on page 26

Prevent Alarm Inhibition
In some IGSS configurations, operators are not permitted to inhibit alarms.
You can configure an operator station to prevent alarms from being inhibited by all operators working on
that operator station.
To prevent operators from inhibiting alarms

1. In the IGSS Master > Design and Setup tab, click the System Configuration button to
open the System Configuration form
2. In the left pane of the System Configuration form, select the operator station you want to configure.
3. In the right pane of the System Configuration form, click the Supervise & Language tab
and clear the Enable Inhibit alarms menu check box
4. Click File > Save Project and close the System Configuration form.
The IGSS configuration will be restarted for the changes to take effect.

Inhibit Notifier
Select this option to inhibit all new alarms that have been configured for the selected object and originate
from the object from being forwarded to the Notifier module for processing. The active alarm will not be
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inhibited and must be processed normally. All alarms from the object will still be registered in the Active
Alarms form and will not be sent to the Notifier module.
A new system alarm number 93 with the text Notifier Inhibit will be created in the Active Alarms form to
track the alarm inhibition.
You can reactivate the inhibited Notifier alarms in the Active Alarm form or directly on the object in the
Supervise module.
See Also

Inhibit Notifier
"Remove Notifier Inhibition" on page 26

Remove Notifier Inhibition
You can remove the inhibited Notifier alarm for the object either by removing the Notifier alarm inhibition
on the alarm itself or by removing the Notifier alarm inhibition on the system alarm which was created
when the Notifier alarm inhibition was created.
If you have acknowledged the system alarm number 93, it will no longer be displayed in the Active
Alarms form, but is displayed in the Alarm Log list instead.
If you want to reactivate the inhibited Notifier alarms for an object through the Active Alarms form, you
must first open the Alarm Log in the left pane of the Active Alarms form, filter the Alarm Log to find the relevant system alarm and then reactivate the inhibited alarm.

It is possible to remove operator access to the object menus in Supervise. If this is the case, inhibiting alarms and reactivating inhibited alarms is not possible.
Remove Notifier alarm inhibition for the object in the Supervise module

1. Click the object on the diagram and select Inhibit Alarms to open the Inhibit Alarms form.
2. In the Inhibit Alarms form, Inhibit alarm transmissions via Notifier group, select the
Enable alarm information on this object as per standard configuration option.
3. Click the OK button to save and close the Inhibit Alarms form.

Remove Notifier alarm inhibition for the object in the Active Alarms form

1. In the IGSS Master > Home tab, click the Alarm button to open the Active Alarms form.
2. In the right pane of the Active Alarms form, find the alarm number 93 with the alarm text
Inhibit Notifier for the object you want to reactivate the inhibited alarm for.
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You can create a new filter to find all inhibited Notifier alarms (Alarm number 93) or you can sort
the Active Alarms form by clicking the Alarm Number or Object Name column heading.

3. Right click the relevant alarm number 93 to open the options menu. The Inhibit Notifier option
is displayed with a check mark.
4. Select the Inhibit Notifier to clear the check mark and reactivate the inhibited alarm.

See Also

Inhibit Notifier Alarms
"Inhibiting Alarms" on page 21
"Reactivating inhibited alarms" on page 23

Removing Alarms
You can remove an alarm from the active alarm list by selecting the alarm and clicking the Actions >
Remove Alarm in the Active Alarms form.
The selected alarm will be removed from the active alarm list and placed in the alarm log with the user
name. The Audit trail database will also be updated if Audit trail functionality has been enabled for the configuration. The selected alarm will be removed from the active alarm list even if the alarm has been inhibited or acknowledged.
Note that the alarm will be removed, but not the object value that triggered the alarm. The object will still
display the value that triggered the alarm in the process diagram. The alarm will be re-evaluated when the
object value is renewed again and if the object value is sufficient to trigger an alarm, a new alarm will be
created.
Operator access to Remove alarm

You must have sufficient rights to inhibit alarms in order to remove alarms. If you do not have the right to
inhibit alarms , you cannot remove alarms and the Remove alarm option in the Actions tab of the
Active Alarms form will be inaccessible.
The user right to remove an alarm is connected to the Enable Inhibit alarms menu check box found on
the Supervise & Language tab of the System Configuration form. If the Enable Inhibit alarms
menu check box has been selected, you can remove alarms.

1.6 Alarm Instructions and Notes
View the operator instruction
You can view an instruction for a given alarm registered in the alarm list or the alarm log, provided that an
operator instruction has been specified by the development engineer during system design.

Procedure
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1. In the alarm list or alarm log, click on the alarm whose operator note you wish to display.
2. In the function menu, select Actions ® Note.
3. The dialogue which appears on the screen provides two tabs:
4. Select Alarm Text to display the predefined instructions to the operator.

Shortcut

1. You are inside the list and a message line is selected.
2. Click the right mouse button.
3. This opens the Actions function box and places it immediately next to the selected message so that you can now conveniently activate the Note command, and open the Alarm Text tab.

See also

Write an alarm note

Background information
You can enter your own comments about an alarm situation. This may be useful if you wish to inform your
colleagues, possibly the operator of the next shift, how you have dealt with the situation and which measures you have taken to eliminate the problem.

Procedure

1. With the mouse, select the alarm in the Acrtive Alarms list for which you wish to write a comment.
2. Right click on the alarm and select Note… or go to the Actions menu and select Note.
3. The dialogue which appears on the screen displays two tabs:
4. Select Alarm Note.
5. The text field underneath the Alarm Note tab is where you can enter your text.
6. After you finish entering your textSave with.

l

Click on

if you wish to print out your comment together with alarm information.

See also
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1.7 Updating and Freezing the Alarm List
Update the list
Background information
The process values shown in the Alarm List and Event List are not continuously refreshed. They are
updated whenever the Worst Value of the object value has changed, or at specific intervals set by the
System Integrator during system design. IGSS therefore provides an Update facility so you can read and
load the newest process values whenever needed.

Procedure

1. In the Tree View, select the list you wish to update.
2. Move into the selected list in the right-hand section of the screen.
3. In the Tool Menu, click Actions > Update.
4. The entire list is updated.

l

For the options of the Actions menu to become available, you must have moved the cursor out of the Tree View into the
alarm list or alarm log !

Shortcut

1. You are inside the list.
2. Simply click the right mouse button.
3. This opens the Actions function box so that you can now conveniently activate the Update function.

See also

Freeze the list

Background information
In situations where you have a cluster of alarms in rapid succession it might be useful to freeze the list for
a short period at its current status. The freeze period is predefined by the development engineer during
system design and cannot be changed by the operator.
Default setting: 30 seconds

Procedure

1. In the Tree View, select the list you wish to freeze.
2. Move into the selected list in the right-hand section of the screen.
3. In the Actions menu, select Freeze.
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l

For the options of the Actions menu to become available, you must have moved the cursor out of the Tree View into the
Alarm List or the Event List.

Shortcut

1. You are inside the list and a message line is selected.
2. Click the right mouse button.
3. This opens the Actions function box so that you can now conveniently activate the Freeze function.

l

A seconds counter in the screen title bar indicates the ‘frozen’ status and the number of seconds still to go.

See also

1.8 Customizing, Sorting and Filtering
Change the list format
Rearrange the columns

1. Open the Alarm List and make sure focus is on the right side of the list by clicking it with the mouse cursor.
2. In the Customize menu, select Alarm List Format…. .
3. The Configure Columns dialogue appears on the screen.
4. The columns are arranged in the order shown in the Columns Displayed list.
5. To change that order, select the title you wish to advance to the left or move to the right, and press
or

respectively.

6. Save your settings with

l

; the Alarm List or Event List will now rearrange its columns accordingly.

With
and
you can at any time reset the format to its original status. This may be the default setting or a default format which you have set yourself using the Save Format as Default command.

See also

Rename a column

1. In the Customize menu, select Alarm List Format…. .
2. The Configure Columns dialogue appears on the screen.
3. In the Columns Displayed list, select the column whose title you wish to rename.
4. The selected name will appear in the window immediately above the list.

5. Now, overwrite the ‘old’ name by the new one and confirm with OK.
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l

With
and
you can at any time reset the format to its original status . This may be the default setting or a default format which you have set yourself using the Save Format as Default command.

See also

Remove columns
Using menu functions

1. In the Customize menu, select Alarm List Format…. .
2. The Configure Columns dialogue appears on the screen.
3. In the Columns Displayed list, select the title you wish to delete.
4. Click on

to delete the title.

5. Confirm with

Directly in the list

1. Click on the right-hand limiting line of the column you wish to remove, using the left mouse button and keep the
mouse button pressed.
2. The cursor changes its shape to a cross and highlights the vertical column delimiter.
3. Keep the left mouse button depressed and drag the cursor to the left until the right line covers the left line. In
this way, the width of the column has been reduced to nothing and the column is removed from the list.

l

With
and
you can at any time reset the format to its original status. This may be the default setting or a default format which you have set yourself using the Save Format as Default command.

l

Only a column which was removed (collapsed) directly in the list by dragging its right-hand limiting line to the left until
clearance, can be retrieved again directly in the list, without using menu functions.
The first method of removing columns is the more permanent layout change. It can only be undone by using the ADD button in the Configure Columns dialogue.

See also

Add columns
Using menu functions

1. In the Customize menu, select Alarm List Format..
2. The Configure Columns dialogue appears on the screen.
3. In the Available Columns list, select the column title you wish to add.
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4. Click on

to insert the name in the Columns Displayed list.

5. Confirm with

l

.

With
and
you can at any time reset the format to its original status. This may be the default setting or a default format which you have set yourself using the Save Format as Default command.

Directly in the list

1. Place the crosshair cursor onto the limiting line of the collapsed column and drag it to the right until the retrieved
column has reached the width required.

l

Only a column which was removed (collapsed) directly in the list by dragging its right-hand limiting line to the left until
clearance, can be retrieved again directly in the list, without using menu functions.

See also

Change the column width
Using menu functions

1. In the Customize menu, select Alarm List Format.
2. The Configure Columns dialogue appears on the screen.
3. In the Columns Displayed list, select the title of the column whose width you wish to change.
4. The current width of this column is displayed in the Width field.

5. Enter a new value to change the size of the column and confirm with

:

Directly in the list

1. Click on the right-hand edge of the column whose size you wish to reduce or widen, using the left mouse button
and keep the mouse button pressed.
2. The cursor changes its shape to a cross and highlights the vertical column delimiting line.
3. Maintaining the left mouse button depressed, drag the line to the left or to the right.
4. Release the mouse button as soon as you have obtained the required column width.
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With
and
you can at any time reset the format to its original status. This may be the default setting or a default format which you have set yourself using the Save Format as Default command.

l

See also

Save the selected list format as default
Save the list format as the default format
Background information
A specific format of the alarm list can be saved in order to act as the default format for all subsequent display operations. The characteristics of this format are defined in the Configure Columns dialogue. As a
result, any settings that might be carried out in the Configure Columns dialogue at later stages can be
conveniently reset to the preset default format by simply pressing the Default button of this dialogue.

Procedure

1. Go Customize ® Alarm List Format …. The Configure Columns dialogue appears.
2. Set the format of the alarm list as required.
3. Confirm with OK.
4. Now, select Customize ® Save Format as Default and activate this command with a mouse click. The format set in
the Configure Columns dialogue will now act as the default format. As a result, pressing the Default button in the
Configure Columns dialogue will have the effect of reverting all format changes to the preset default format.

If no user-specific default format was set, or if the system designer has disabled the Save Format as Default command, pressing the Default button in the Configure Columns dialogue restores the IGSS default format.

l

See also

Sort the alarm messages
Change the sorting order in the list
There are two different ways to sort the lines of the list and define the sorting criteria:
l

using the functions of the Customize menu

l

directly in the list

l

The alarm list is displayed and you wish to have all alarms sorted according to their time of occurrence so that the most
recent alarm is shown at the top of the list. This information is registered in the Start Time column.

Using menu functions
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1. In the Customize menu, select the edit function Set Sort Order …
2. The Sorting Order dialogue appears on the screen.
3. In the table, click on the Start Time entry.
4. Select

and keep on clicking on

to step by step move Start Time to the top of the list.

5. Confirm with
6. The alarm messages are now sorted so that the most recent alarms are at the top of the list and the oldest alarms are
displayed at the end of the list.
7. Generally, you define the priorities of the sorting criteria by sorting the column titles in the table using
and

, and for each sorting criterion you decide whether it is to be applied in

or

order.

Directly in the list
You can change the sorting order directly in the alarm list (or: alarm log) by clicking on the column
title you wish to use as sorting criterion. For our example:

1. Click on the column title Start Time.
2. You will see that the list is immediately sorted in chronological order, i.e. the most recent alarms are shown on the
top of the list.
3. If you click once again on Start Time, the order is reversed and the ‘oldest’ messages are moved to the top of the
list.

l

The default sorting criterion is: Alarm State

l

With
and
you can at any time reset the format to its original status. This may be the default setting or a default format which you have set yourself using the Save Format as Default command.

See also

Filter out specific information from the list
Define a new filter
The Customize menu provides three functions that help you to define and edit filter criteria for for filters in
the Alarm List or Event List: New Filter Edit Filter and Delete Filter.
l

To set a new filter, you must have selected Active Alarms/Alarm Log or Active Events/Event Log in the Tree View in
the left-hand section of the screen.

l

You wish to see all acknowledged messages that have occurred in the period from April 10 to April 15, 1997. We will
define and save three filter conditions and logically link them by an AND operator. This filter criterion is then saved under
the name of “Filter1”.

Procedure

1. Press Customize ® New Filter.
2. The dialogue Defining Filters for Alarm List is opened.
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3. Under Edit Conditions, define the Begin Date.

4. Click Add to List to save the first condition in the Existing Filter Conditions table.
5. Select the logical operator AND.
6. Now define the End Date and again save it with Add to List.
7. Again, select AND as the logical operator.
8. Finally, define the third condition:
Property: Acknowledge Date
Condition: between
Value: set date and time of the interval
9. Save the third condition with Add to List.

10. Now name the new filter
11. Confirm / Save with

.

To display a list containing only those messages that meet the new filter criteria, close the Defining
Filters for Alarm List dialogue and navigate to the Tree View, on the left-hand section of the screen.
Click Active Alarms and select Filter1.
l

The Alarm Log has the default filter Past 1day Log which may have been enabled or disabled for your application by the
system design engineer. This standard filter can neither be changed nor deleted.

Format as 'Alarm Print'
If this option is selected, up to three extra lines will be shown for each alarm. These will show the historic object value, as it was,
when the alarm was started, acknowledged or ended. This format is equal to the format used for alarm list printouts.

See also

Edit an existing filter
The Customize menu of the Menu Bar provides THREE functions that help you to define and edit filter criteria for the display of the alarm list or the alarm log: New Filter, Edit Filter and Delete Filter.
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To edit an existing filter, you must have selected Active Alarms/Alarm Log or Active Events/Event
Log in the Tree View in the left-hand section of the screen, and in the tree branch - the filter you wish to
change.

Procedure

1. In the Menu Bar, select Customize® Edit Filter.
2. The dialogue Defining Filters for Alarm List is opened.
3. In the list Existing Filter Conditions, select the filter criterion you wish to change.
4. Under Edit Conditions, modify the filter condition and confirm with OK.
5. In the Save Filter as box you may save the modified filter under the same name, or create an additional filter by saving it under a new name.

l

The Alarm Log has the default filter Past 1day Log which may have been enabled or disabled for your application by the
system design engineer. This standard filter can neither be changed nor deleted.

Note: If the filter is protected, you must have the Can Administer right to edit it. User rights are
defined in the User Administration program.
See also

Set a default Active Alarm list filter
You can set a specific filter as the default filter. In a multi-user environment, this setting only applies to the
machine on which it is set. The default filter can thus not be uploaded to the IGSS server and distributed to
the other operator stations.
The default filter will be applied when you open the Alarm Module.

1. Select the filter you want to set as the default. The system default is the root filter named Active Alarms.
2. Select Customize ® Set as Default Filter or click the corresponding icon in the toolbar,
lock is recessed when you select the default filter.

. Notice that the pad-

Set a default Alarm log filter
If the alarm log limit of 10,000 records is exceeded, the Alarm log list will not be displayed.
If you want to see the alarm log list, you must create an Alarm log filter in order to filter and display the
Alarm log list.
You can create a default alarm log filter which will automatically filter the alarm log list when you click the
Alarm log folder in the left pane of the Alarm list form.
To create a default Alarm log list filter, you must create an Alarm log filter and make sure to include an
asterisk '*' to the filter name.
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For example, if you create an alarm log filter called "Pump alarms ", you can set the filter as the default
Alarm log list filter by changing the name of the filter to "*pump alarms".
You can only have one default Alarm log list filter.
See Also

"Define a new filter" on page 54
Delete an existing filter
The Customize menu of the Menu Bar provides THREE functions that help you to define and edit filter criteria for the display of the alarm list or the alarm log: New Filter, Edit Filter and Delete Filter.
To delete an existing filter, you must have selected Active Alarms/Alarm Log or Active
Events/Event Log in the Tree View in the left-hand section of the screen, and in the tree branch - the
filter you wish to remove.

Procedure

1. In the Menu Bar, select Customize® Delete Filter.

CAREFUL
The filter is deleted IMMEDIATELY and WITHOUT any further confirmation !

l

The Alarm Log has the default filter Past 1day Log which may have been enabled or disabled for your application by the
system design engineer. This standard filter can neither be changed nor deleted.

See also

1.9 Printing Alarms
Direct alarm message printing
The system designer defines the alarm printer in the System Configuration program. For each object in
the configuration the system designer decides whether or not to print alarm messages directly. If the option
is enabled, the alarm message will be printed on the alarm printer.
The operator has no access to the above functions.
If enabled by the system designer, the plant operator has the right to save the current alarm list format as
the default format for direct alarm message printing.

See also
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Use the alarm list format for direct message printing
A specific format of the alarm list can be saved in order to act as the default format for message logging on
the alarm printer. The characteristics of this format are defined in the Configure Columns dialogue. As a
result, any settings that might be carried out in the Configure Columns form at later stages can be conveniently reset to the preset default format by clicking the Default button in the Configure Columns
form .

Procedure

1. Go Customize ® Alarm List Format …. The Configure Columns dialogue appears.
2. Set the format of the alarm list as required.
3. Confirm with OK.
4. Now, select File ® Save Format for Alarm Printer and activate this command with a mouse click. The format set in
the Configure Columns dialogue will now act as the default format for alarm printing. As a result, pressing the
Default button in the Configure Columns dialogue will have the effect of reverting all format changes to the preset
default format.

l

If no user-specific default format was set, or if the system designer has disabled the Save Format for Alarm Printer
command, pressing the Default button in the Configure Columns dialogue restores the igss default format.

See also

Printing the alarm list /alarm log
Printing out the Alarm List or Alarm Log as it is displayed on the screen.

1. In the menu bar, select File ® Print.
2. Make your selections in the Print dialogue.
3. Confirm with OK.

l

Cut to Paper Width
If this function is selected, the contents of the displayed Alarm List or Log is cut off if it exceeds the right margin of the
printing paper.
If this function is not selected and the contents of the list exceeds the width of one print page, printing is continued on a
second page. In this way you may join two printed pages to see the entire contents of the list on paper.

See also

Alarm: Command line interface
Introduction
The command line interface is an alternative to the graphical interface to this program. It allows you to
manipulate the program either directly from a command prompt or from the Job Scheduler Module.
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Using this interface, you can automatically print the Alarm List with a fixed interval or activated on an
event in the IGSS system. You can also send the output in an e-mail or export it as a comma-separated file
(.CSV)

Procedure
Click here
to learn how to use the command line interface either with the Job Scheduler Module or the
Windows command prompt.

Syntax conventions
The following symbols are used:

Symbol

Bold

Description

Required parameter.

<placeholder> Placeholder for a variable parameter.
|
Separates required parameters. You must use at least one of
(pipe symbol) these parameters in the syntax and you may use two or more of
them.
NOTE: To separate these parameters, put a space between
them.
[parameter] Optional parameter that you may include in the command line.

Syntax
Use the following syntax (separate parameters with a space):

Alm -f<filter name> [-ds<start date>] [-ts<start time>] [-de<end date>] [-te<end time>] [-all]
[-note] [-page]

l

l

You must check the Prompt for period box in the Defining Filters for Alarm List dialog
when you create a filter that you will access from the command line. If disabled, Alarm will
use the default period.

The last three command line parameters are equivalent to the three check boxes in the print
dialogue of the alarm program.

Parameter

Description

-f<filter
name>

Name of the filter to use. If the name contains spaces, enclose the name in quotation
marks (""). You can also use the root filters: "Active Alarms" and "Alarm Log".

-ds<start
date>

Start date in the format yyyy/mm/dd or as an offset defined with the $ parameter (offset in days).
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Parameter

-ts<start
time>

Description

Start time in the format hh:mm:ss or as an offset defined with the $ parameter (offset
in seconds).

-de<end date> End date in the format yyyy/mm/dd or as an offset defined with the $ parameter (offset in days).
-te<end time> End time in the format hh:mm:ss or as an offset defined with the $ parameter (offset
in seconds).
-all

All columns are printed (otherwise the columns exceeding one page are not printed)

-note

Includes alarm notes on the printout.

-page

Inserts page breaks after alarm notes.

-landscape

Landscape makes alarm print in landscape mode

-CSV

Output is to be exported as a comma-separated file (.CSV) and not printed.
The comma-separated file must either be saved at a location using the -file<path>
parameter and/or sent as an attachment to an e-mail message using the -mail<address> parameter.
You can add a title to the e-mail message by using the -title parameter.

-file<path>

The full path to the destination file, including the name of the .csv file.
The default filename is yyyy-mm-dd-hh-mm-ss.csv
The default file path is the GSS folder of the local IGSS installation.

-mail<address>

The output is to be sent as an attachment to the recipient's e-mail address. If the output is to be sent to more than one e-mail recipient, separate any additional e-mail
addresses with a semicolon.
You do not need to use the -file<path> to include the .csv in the e-mail message, but if
you do use the -file<path> parameter, then the specified file will be included in the email message.
If you do not use the -file<path> parameter, the default file name will be used for the
e-mail attachment.

-title

The subject line in the e-mail message.

Job Scheduler example
This example prints the alarms matching the Analog Alarms filter. The start date is set to the previous
day ($date-1) and end date is set to today $(date). Start time (-ts) and end time (-te) are both set to 7:00
a.m. All columns are printed and alarm notes are included.

Program path:

"[IGSS InstallPath]\Gss\Alm.exe"
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Parameters:

-f"Analog Alarms" -ds$(date-1) -ts07:00:00 -de$(date) -te07:00:00 -all
–note
Working folder:
-

Command prompt example
This command line prints all alarms matching the Purification filter from the previous day. The printout
shows all columns and includes alarm notes.

Alm -fPurification -ds$-1 -ts00:00:00 -de$ -te00:00:00 -all -note
1.10 System Alarm
The System Alarm
In the IGSS software, there is an object called System. This object is used by the IGSS system to generate
alarms under specific conditions.
l

The System object, which is a predefined analog object, can be viewed in the Object Browser in the Definition program. If this object is deleted or renamed, the IGSS system will crash and freeze up until the object is restored.

A system alarm is triggered from the System object under the following four conditions.

1. When the amount of free space on the hard disk of the IGSS single user or server PC is nearly gone
2. When the path to the IGSS application’s report folder is incorrect
3. When there are insufficient Windows user permissions given to the report folder when running in a multi-user environment
4. When the occurrence of an Event in the Event list is also to be displayed in the Active Alarm list

Let’s look at the alarm messages displayed for each situation.

1. Insufficient hard disk space
When the IGSS system registers a low level of hard disk space, then the System alarm is triggered and a
System alarm warning message is displayed:
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Figure 1: Basic System alarm message
You must then shut the IGSS system down and remove enough files from the hard disk to free up at least
20% of hard disk capacity. Then start the IGSS system up again.
The occurrence of this alarm by itself is rare because hard disk capacity nowadays is hardly ever exceeded
by normal SCADA1 systems.
However, the alarm is triggered in connection with the presence of other conditions, which need attention
by the user. These are described in the next two cases.

2. Error in connection with the IGSS application’s report folder: cannot find the report folder

When this situation occurs, the ALL LOGGING STOPPED alarm, as shown in Figure 1 above, will be triggered as well as a dialog box with an alarm message. When this happens, the ALL LOGGING STOPPED
alarm can be ignored as the true cause of the alarm state.
This alarm arises typically when configuring a multi-user system and looks like this:

Figure 2: Cannot find the report folder warning

1 Supervisory Control & Data Acquisition
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This message indicates that the path to the IGSS application’s report folder has somehow been incorrectly
keyed in. Therefore, check first in the System Configuration module on the server PC on the Configuration tab under Report folder. Check the following two things:

1. Make sure that you’ve correctly keyed in the UNC path to the report folder, i.e. \\<IP address>or <PC name>\<report
folder name>\

l

Remember to include the last forward slash after the name of the report folder.

2. Make sure that you’ve spelled everything correctly

This should remedy the problem.

3. Error in connection with the IGSS application’s report folder: access denied

When this situation occurs, the ALL LOGGING STOPPED alarm, as shown above, will be triggered as well
as a dialog box with an alarm message. When this happens, the ALL LOGGING STOPPED alarm can be
ignored as the true cause of the alarm state.
This alarm arises typically when configuring a multi-user system and looks like this:

Figure 3: Access denied warning
This message indicates that sharing and/or setting of permissions on the report folder has not been correctly carried out. Do the following:

1. Use Windows Explore to find the folder where the IGSS application resides.
2. Right click on the folder name and choose Sharing and Security…
3. Share the folder and then click on the Permissions button to set user permissions to Full Control.
4. Click OK to save and exit.

This should remedy the problem.

4. Display an Event in the Active Alarms list
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This last example of the triggering of a System alarm is not related to an error situation. Here the System
object is used to display the occurrence of an Event in the Active Alarms list. For a detailed explanation
click this link Event.
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Chapter 2: The Event List
2.1 What is the Event List ?
The operator uses the Event List to get a quick overview of the most important system and object events.
The events in the list are user-defined and can be configured both from the Definition program and the
Supervise program.
The Event List is presented just below the Alarm List. It contains two root nodes, Active Events and Event
Log. For both of these root nodes, filters can be defined exactly as in the Alarm List.
As is the case for the Alarm List, columns can be rearranged and the events can be sorted differently.
For details about the individual event types, the fields in the list, etc., read the other topics in this book or
click the See Also button.

2.2 Active Events and the Event Log
The Event List has two root nodes in the tree view.
l

The Active Events node shows all events from the last hour or the 500 latest events.

l

The Event Log node shows all historical and active events. The max. no. of events in the list is governed by the Max.
alarm log entries setting on the Alarm tab of the System Configuration program. Please note that the max. number
of entries include both alarms and events.

For both nodes filters can be defined. The filters will appear below the root node. The root node can be
expanded to show the filters or collapsed to hide the filters.
Defining filters is very easy. Click here for details.
In this example, we have defined a filter extracting user login/logout information. We know that the event
type has been named “User login/logout” so this is our filter criterion.
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2.3 The fields in the Event List
The table below shows an explanation of the fields specific to the Event List. The name of the event is
defined either in the Definition or the Supervise Modules.
For an overview of the event types, click the header in the table.

Event type

Event

Info 1

Info 2

Info 3

OP Connect/Disconnect

User- “Connect”, “Disconnect”, “Lost IGSS station name
defined connection”, “LAN B”
name

-

Periodical

User- defined
name

-

-

System start/stop

User- “Data collection started” or
defined ”Data collection stopped”
name

-

-

User defined

User- defined
name

Object name

Area name

User login/logout

User- “Login” or
defined ”Logout”
name

User name

IGSS station name

Writing
stopped/started

User- “Start write” or
defined ”Stop write”
name

-

-

Error packet

User- Driver number, node number
defined
name

Error group
(decimal or hexadecimal)

Error code, subcode
(decimal or hexadecimal)

2.4 Showing events in the Alarm List
Enabling alarm on event
When new events are defined, it is possible to enable the Alarm on event check box. This means that the
event will appear both in the Event List and in the Alarm List. The operator will thus see the number of
alarms change in the Alarm Icon and see the alarm in the list.
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Viewing events in the Alarm List
The alarm will be shown as alarm number 90. The alarm text will be the event name. The alarm properties
including alarm and acknowledgment colors are taken from alarm number 90. If required, the alarm properties can be changed in the Definition program.
This example shows a number of events at the top of the Alarm List.

Acknowledging event alarms
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From the Alarm List the operator can acknowledge the alarm. Once acknowledged, the alarm is also
ended and is archived in the Alarm Log.

2.5 Printing event alarms
Prepare the Event List for printing

1. In the Customize menu, select Alarm Print Format.
2. Do the following:

l

In the Columns Displayed list, remove all unwanted columns.

l

In the All Columns list, select the columns specific to the Event List one-by-one and click the Add button.
These fields will be printed when a new event occurs. For all other alarms, the fields will be empty.

l

In the Columns Displayed list, use the Move Up and Move Down buttons to adjust the order.

Show picture

3. Click the OK button.

Print the Event List

1. In the File menu, select Print.
2. If required, change the print settings.
3. Click Print.

l

The list will now be printed according to the setup in the Alarm Print Format dialog box.

Print events on the alarm printer
In order to have all events printed on the alarm printer as soon as they occur, set up the following:

1. In the System Configuration program, click the Reports tab.
2. In the Alarm printer section, select Direct (one line at a time on a matrix printer) or Windows (the page is printed
when the page is filled).
3. Click the Printer button and select the relevant printer.
4. Close the program and save changes.
5. Open the Definition program
6. In the Edit menu, select Alarm Texts.
7. Select alarm text number 98 named Event and click Edit.
8. In the Edit Alarm Description dialog box, select the To Print check box.

Show picture
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9. Click OK and then Close.
10. In the File menu, select Install Configuration.

l

If you select Online Update in this case, the change will not be applied. The Data Collection must be restarted for the
change to take effect.

4. From the IGSS Master > Home Tab, click the Restart button to re- start the configuration .

l

New events will now be printed on the alarm printer. The alarm number will be 98 and the alarm text will be “Event”.

2.6 Updating and Freezing the Event List
Update the list
Background information
The process values shown in the Alarm List and Event List are not continuously refreshed. They are
updated whenever the Worst Value of the object value has changed, or at specific intervals set by the
System Integrator during system design. IGSS therefore provides an Update facility so you can read and
load the newest process values whenever needed.

Procedure

1. In the Tree View, select the list you wish to update.
2. Move into the selected list in the right-hand section of the screen.
3. In the Tool Menu, click Actions > Update.
4. The entire list is updated.

l

For the options of the Actions menu to become available, you must have moved the cursor out of the Tree View into the
alarm list or alarm log !

Shortcut

1. You are inside the list.
2. Simply click the right mouse button.
3. This opens the Actions function box so that you can now conveniently activate the Update function.

See also

Freeze the list

Background information
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In situations where you have a cluster of alarms in rapid succession it might be useful to freeze the list for
a short period at its current status. The freeze period is predefined by the development engineer during
system design and cannot be changed by the operator.
Default setting: 30 seconds

Procedure

1. In the Tree View, select the list you wish to freeze.
2. Move into the selected list in the right-hand section of the screen.
3. In the Actions menu, select Freeze.

l

For the options of the Actions menu to become available, you must have moved the cursor out of the Tree View into the
Alarm List or the Event List.

Shortcut

1. You are inside the list and a message line is selected.
2. Click the right mouse button.
3. This opens the Actions function box so that you can now conveniently activate the Freeze function.

l

A seconds counter in the screen title bar indicates the ‘frozen’ status and the number of seconds still to go.

See also

2.7 Customizing, Sorting and Filtering
Change the list format
Rearrange the columns

1. Open the Alarm List and make sure focus is on the right side of the list by clicking it with the mouse cursor.
2. In the Customize menu, select Alarm List Format…. .
3. The Configure Columns dialogue appears on the screen.
4. The columns are arranged in the order shown in the Columns Displayed list.
5. To change that order, select the title you wish to advance to the left or move to the right, and press
or

respectively.

6. Save your settings with

l

; the Alarm List or Event List will now rearrange its columns accordingly.

With
and
you can at any time reset the format to its original status. This may be the default setting or a default format which you have set yourself using the Save Format as Default command.

See also
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Rename a column

1. In the Customize menu, select Alarm List Format…. .
2. The Configure Columns dialogue appears on the screen.
3. In the Columns Displayed list, select the column whose title you wish to rename.
4. The selected name will appear in the window immediately above the list.

5. Now, overwrite the ‘old’ name by the new one and confirm with OK.

l

With
and
you can at any time reset the format to its original status . This may be the default setting or a default format which you have set yourself using the Save Format as Default command.

See also

Remove columns
Using menu functions

1. In the Customize menu, select Alarm List Format…. .
2. The Configure Columns dialogue appears on the screen.
3. In the Columns Displayed list, select the title you wish to delete.
4. Click on

to delete the title.

5. Confirm with

Directly in the list

1. Click on the right-hand limiting line of the column you wish to remove, using the left mouse button and keep the
mouse button pressed.
2. The cursor changes its shape to a cross and highlights the vertical column delimiter.
3. Keep the left mouse button depressed and drag the cursor to the left until the right line covers the left line. In
this way, the width of the column has been reduced to nothing and the column is removed from the list.

l

With
and
you can at any time reset the format to its original status. This may be the default setting or a default format which you have set yourself using the Save Format as Default command.

l

Only a column which was removed (collapsed) directly in the list by dragging its right-hand limiting line to the left until
clearance, can be retrieved again directly in the list, without using menu functions.
The first method of removing columns is the more permanent layout change. It can only be undone by using the ADD button in the Configure Columns dialogue.
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See also

Add columns
Using menu functions

1. In the Customize menu, select Alarm List Format..
2. The Configure Columns dialogue appears on the screen.
3. In the Available Columns list, select the column title you wish to add.
4. Click on

to insert the name in the Columns Displayed list.

5. Confirm with

l

.

With
and
you can at any time reset the format to its original status. This may be the default setting or a default format which you have set yourself using the Save Format as Default command.

Directly in the list

1. Place the crosshair cursor onto the limiting line of the collapsed column and drag it to the right until the retrieved
column has reached the width required.

l

Only a column which was removed (collapsed) directly in the list by dragging its right-hand limiting line to the left until
clearance, can be retrieved again directly in the list, without using menu functions.

See also

Change the column width
Using menu functions

1. In the Customize menu, select Alarm List Format.
2. The Configure Columns dialogue appears on the screen.
3. In the Columns Displayed list, select the title of the column whose width you wish to change.
4. The current width of this column is displayed in the Width field.

5. Enter a new value to change the size of the column and confirm with

Directly in the list
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1. Click on the right-hand edge of the column whose size you wish to reduce or widen, using the left mouse button
and keep the mouse button pressed.
2. The cursor changes its shape to a cross and highlights the vertical column delimiting line.
3. Maintaining the left mouse button depressed, drag the line to the left or to the right.
4. Release the mouse button as soon as you have obtained the required column width.

l

With
and
you can at any time reset the format to its original status. This may be the default setting or a default format which you have set yourself using the Save Format as Default command.

See also

Save the selected list format as default
Save the list format as the default format
Background information
A specific format of the alarm list can be saved in order to act as the default format for all subsequent display operations. The characteristics of this format are defined in the Configure Columns dialogue. As a
result, any settings that might be carried out in the Configure Columns dialogue at later stages can be
conveniently reset to the preset default format by simply pressing the Default button of this dialogue.

Procedure

1. Go Customize ® Alarm List Format …. The Configure Columns dialogue appears.
2. Set the format of the alarm list as required.
3. Confirm with OK.
4. Now, select Customize ® Save Format as Default and activate this command with a mouse click. The format set in
the Configure Columns dialogue will now act as the default format. As a result, pressing the Default button in the
Configure Columns dialogue will have the effect of reverting all format changes to the preset default format.

l

If no user-specific default format was set, or if the system designer has disabled the Save Format as Default command, pressing the Default button in the Configure Columns dialogue restores the IGSS default format.

See also

Sort the alarm messages
Change the sorting order in the list
There are two different ways to sort the lines of the list and define the sorting criteria:
l

using the functions of the Customize menu

l

directly in the list
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The alarm list is displayed and you wish to have all alarms sorted according to their time of occurrence so that the most
recent alarm is shown at the top of the list. This information is registered in the Start Time column.

l

Using menu functions

1. In the Customize menu, select the edit function Set Sort Order …
2. The Sorting Order dialogue appears on the screen.
3. In the table, click on the Start Time entry.
4. Select

and keep on clicking on

to step by step move Start Time to the top of the list.

5. Confirm with
6. The alarm messages are now sorted so that the most recent alarms are at the top of the list and the oldest alarms are
displayed at the end of the list.
7. Generally, you define the priorities of the sorting criteria by sorting the column titles in the table using
and

, and for each sorting criterion you decide whether it is to be applied in

or

order.

Directly in the list
You can change the sorting order directly in the alarm list (or: alarm log) by clicking on the column
title you wish to use as sorting criterion. For our example:

1. Click on the column title Start Time.
2. You will see that the list is immediately sorted in chronological order, i.e. the most recent alarms are shown on the
top of the list.
3. If you click once again on Start Time, the order is reversed and the ‘oldest’ messages are moved to the top of the
list.

l

The default sorting criterion is: Alarm State

l

With
and
you can at any time reset the format to its original status. This may be the default setting or a default format which you have set yourself using the Save Format as Default command.

See also

Filter out specific information from the list
Define a new filter
The Customize menu provides three functions that help you to define and edit filter criteria for for filters in
the Alarm List or Event List: New Filter Edit Filter and Delete Filter.
l

To set a new filter, you must have selected Active Alarms/Alarm Log or Active Events/Event Log in the Tree View in
the left-hand section of the screen.

l

You wish to see all acknowledged messages that have occurred in the period from April 10 to April 15, 1997. We will
define and save three filter conditions and logically link them by an AND operator. This filter criterion is then saved under
the name of “Filter1”.

Procedure
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1. Press Customize ® New Filter.
2. The dialogue Defining Filters for Alarm List is opened.
3. Under Edit Conditions, define the Begin Date.

4. Click Add to List to save the first condition in the Existing Filter Conditions table.
5. Select the logical operator AND.
6. Now define the End Date and again save it with Add to List.
7. Again, select AND as the logical operator.
8. Finally, define the third condition:
Property: Acknowledge Date
Condition: between
Value: set date and time of the interval
9. Save the third condition with Add to List.

10. Now name the new filter
11. Confirm / Save with

.

To display a list containing only those messages that meet the new filter criteria, close the Defining
Filters for Alarm List dialogue and navigate to the Tree View, on the left-hand section of the screen.
Click Active Alarms and select Filter1.
l

The Alarm Log has the default filter Past 1day Log which may have been enabled or disabled for your application by the
system design engineer. This standard filter can neither be changed nor deleted.

Format as 'Alarm Print'
If this option is selected, up to three extra lines will be shown for each alarm. These will show the historic object value, as it was,
when the alarm was started, acknowledged or ended. This format is equal to the format used for alarm list printouts.

See also

Edit an existing filter
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The Customize menu of the Menu Bar provides THREE functions that help you to define and edit filter criteria for the display of the alarm list or the alarm log: New Filter, Edit Filter and Delete Filter.
To edit an existing filter, you must have selected Active Alarms/Alarm Log or Active Events/Event
Log in the Tree View in the left-hand section of the screen, and in the tree branch - the filter you wish to
change.

Procedure

1. In the Menu Bar, select Customize® Edit Filter.
2. The dialogue Defining Filters for Alarm List is opened.
3. In the list Existing Filter Conditions, select the filter criterion you wish to change.
4. Under Edit Conditions, modify the filter condition and confirm with OK.
5. In the Save Filter as box you may save the modified filter under the same name, or create an additional filter by saving it under a new name.

l

The Alarm Log has the default filter Past 1day Log which may have been enabled or disabled for your application by the
system design engineer. This standard filter can neither be changed nor deleted.

Note: If the filter is protected, you must have the Can Administer right to edit it. User rights are
defined in the User Administration program.
See also

Set a default Active Alarm list filter
You can set a specific filter as the default filter. In a multi-user environment, this setting only applies to the
machine on which it is set. The default filter can thus not be uploaded to the IGSS server and distributed to
the other operator stations.
The default filter will be applied when you open the Alarm Module.

1. Select the filter you want to set as the default. The system default is the root filter named Active Alarms.
2. Select Customize ® Set as Default Filter or click the corresponding icon in the toolbar,
lock is recessed when you select the default filter.

. Notice that the pad-

Delete an existing filter
The Customize menu of the Menu Bar provides THREE functions that help you to define and edit filter criteria for the display of the alarm list or the alarm log: New Filter, Edit Filter and Delete Filter.
To delete an existing filter, you must have selected Active Alarms/Alarm Log or Active
Events/Event Log in the Tree View in the left-hand section of the screen, and in the tree branch - the
filter you wish to remove.

Procedure
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1. In the Menu Bar, select Customize® Delete Filter.

CAREFUL
The filter is deleted IMMEDIATELY and WITHOUT any further confirmation !

l

The Alarm Log has the default filter Past 1day Log which may have been enabled or disabled for your application by the
system design engineer. This standard filter can neither be changed nor deleted.

See also
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Chapter 3: The Super Alarm Program
3.1 What is Super Alarm ?
Definition
Super Alarm allows you to receive alarms from plants at remote locations via the Internet. These alarms
can be viewed on so-called client PCs at one or more locations geographically removed from the plant.

Use
The following describes some typical situations where Super Alarm might be employed.
l

Main plant responsible for alarm surveillance of one or more secondary plants

l

Production operations HQ in a large production complex located away from actual production lines
responsible for total production surveillance.

l

Evening, night shift or weekend duty personnel carrying out surveillance responsibilities from their
private residences.

3.2 How it works
The Super Alarm workflow
The following flowchart gives you an overview of the workflow involved in setting up and using Super
Alarm.
For details about a step, click its box.

Graphical overview
The following figure shows a simple Super Alarm setup.
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3.3 Before you begin
Before you start setting up the alarm server(s) and client(s), the following preconditions must be met:
l

The AMS/WinPager option must have been purchased and installed on the alarm server(s).

l

Each alarm that you want to view through Super Alarm must have the To WinPager option enabled
(this is done as part of the alarm text definition)

l

The alarm server(s) and client(s) must be connected to the Internet via TCP/IP

When these preconditions are fulfilled, click See Also to continue with the alarm server and client setup
procedures.

See Also

3.4 Set up the alarm server
On the alarm server, you specify each user you want to authorize to view alarms via Super Alarm.

1. Open the System Configurationprogram.
2. Select the server station and click the Access Control tab.
3. Click Add User.
4. Type the appropriate user name and password and click OK.

l

The users permitted to use Super Alarm are completely separate entities from the users defined in
User Administration. An authorised Super Alarm user need not necessarily be an authorised user in
User Administration and vice versa.
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5. Repeat steps 2 and 3 for all Super Alarm users.
6. In the TCP/IP port field, type the logical port number you want to use.

l

It is recommended to use the default port number. Do not use port numbers lower than 4000, as they are often used for
other purposes.

The Super Alarm server is now set up and the client can connect to the server using an authorized user
name and password.

To edit or remove a Super Alarm user, select the user name and click Edit
User or Remove User, respectively.

3.5 Set up the alarm client
If you have a full IGSS installation, skip step 1.

1. It is recommended that you install the Demo version of IGSS onto your computer to run the
Super Alarmprogram.
2. To start the Super Alarm program, make a shortcut to the Alarm program and add the command
line parameter –s. Double-click the shortcut.

Show picture

1. Select Internet ® Configure Servers.
2. Click Add.
3. Do one of the following:

l

In the Server Name box, type the computer name or host name of the alarm server
(do not use the IGSS server name).

l

In the IP Address box, type the IP address of the alarm server.

2. In the TCP/IP Port number box, type the logical TCP/IP port number as specified in System
configuration form on the alarm server.
The default port number is automatically suggested.
3. In the User name box, type the name of an authorized user.
4. In the Password box, type the password.
5. In the Description of server box, you can type an optional description of the server.
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1. Click OK.
2. Repeat steps 4 to 10 for each alarm server you want to connect to.
3. Click Close.

l

The alarms from the configured servers will now appear in the list. The Server ID column shows
you which server sent the alarm. For an example, click See Also.

If you get three asterisks (***) in the Server ID column, the alarm client is not connected to the alarm
server. In that case, check that the TCP/IP connection between the server and the client is properly
configured.

3.6 Example: Viewing alarms from remote plants
In this example, the alarm client is connected to three different IGSS servers: The Main, East, and South
plants.
Note that the Server ID column identifies the server which delivered the alarm. In this case, we have configured the servers with the full host name including the Web server name, for example, South.sevent.dk.
Alternatively, you can use the computer name or the IP address of the alarm server. But the latter is, of
course, harder to recognize for the user.
To show you what happens if the alarm client is not properly connected to the alarm server, a fourth IGSS
server has been configured, North.sevent.dk. As you can see, three asterisks (***) appear in the
Server ID column and the Alarm text “Not connected to server” is shown.
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Chapter 4: Command Line Interface
4.1 Alarm: Command line interface
Introduction
The command line interface is an alternative to the graphical interface to this program. It allows you to
manipulate the program either directly from a command prompt or from the Job Scheduler Module.
Using this interface, you can automatically print the Alarm List with a fixed interval or activated on an
event in the IGSS system. You can also send the output in an e-mail or export it as a comma-separated file
(.CSV)

Procedure
Click here
to learn how to use the command line interface either with the Job Scheduler Module or the
Windows command prompt.

Syntax conventions
The following symbols are used:

Symbol

Bold

Description

Required parameter.

<placeholder> Placeholder for a variable parameter.
|
Separates required parameters. You must use at least one of
(pipe symbol) these parameters in the syntax and you may use two or more of
them.
NOTE: To separate these parameters, put a space between
them.
[parameter] Optional parameter that you may include in the command line.

Syntax
Use the following syntax (separate parameters with a space):

Alm -f<filter name> [-ds<start date>] [-ts<start time>] [-de<end date>] [-te<end time>] [-all]
[-note] [-page]

l

You must check the Prompt for period box in the Defining Filters for Alarm List dialog
when you create a filter that you will access from the command line. If disabled, Alarm will
use the default period.
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l

The last three command line parameters are equivalent to the three check boxes in the print
dialogue of the alarm program.

Parameter

Description

-f<filter
name>

Name of the filter to use. If the name contains spaces, enclose the name in quotation
marks (""). You can also use the root filters: "Active Alarms" and "Alarm Log".

-ds<start
date>

Start date in the format yyyy/mm/dd or as an offset defined with the $ parameter (offset in days).

-ts<start
time>

Start time in the format hh:mm:ss or as an offset defined with the $ parameter (offset
in seconds).

-de<end date> End date in the format yyyy/mm/dd or as an offset defined with the $ parameter (offset in days).
-te<end time> End time in the format hh:mm:ss or as an offset defined with the $ parameter (offset
in seconds).
-all

All columns are printed (otherwise the columns exceeding one page are not printed)

-note

Includes alarm notes on the printout.

-page

Inserts page breaks after alarm notes.

-landscape

Landscape makes alarm print in landscape mode

-CSV

Output is to be exported as a comma-separated file (.CSV) and not printed.
The comma-separated file must either be saved at a location using the -file<path>
parameter and/or sent as an attachment to an e-mail message using the -mail<address> parameter.
You can add a title to the e-mail message by using the -title parameter.

-file<path>

The full path to the destination file, including the name of the .csv file.
The default filename is yyyy-mm-dd-hh-mm-ss.csv
The default file path is the GSS folder of the local IGSS installation.

-mail<address>

The output is to be sent as an attachment to the recipient's e-mail address. If the output is to be sent to more than one e-mail recipient, separate any additional e-mail
addresses with a semicolon.
You do not need to use the -file<path> to include the .csv in the e-mail message, but if
you do use the -file<path> parameter, then the specified file will be included in the email message.
If you do not use the -file<path> parameter, the default file name will be used for the
e-mail attachment.

-title

The subject line in the e-mail message.

Job Scheduler example

- 63 -

IGSS V10, User Guide

This example prints the alarms matching the Analog Alarms filter. The start date is set to the previous
day ($date-1) and end date is set to today $(date). Start time (-ts) and end time (-te) are both set to 7:00
a.m. All columns are printed and alarm notes are included.

Program path:

"[IGSS InstallPath]\Gss\Alm.exe"
Parameters:

-f"Analog Alarms" -ds$(date-1) -ts07:00:00 -de$(date) -te07:00:00 -all
–note
Working folder:
-

Command prompt example
This command line prints all alarms matching the Purification filter from the previous day. The printout
shows all columns and includes alarm notes.

Alm -fPurification -ds$-1 -ts00:00:00 -de$ -te00:00:00 -all -note
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Chapter 5: Reference and Lookup
5.1 Conventions in this Manual
The following typographical conventions are used:

Convention

Description

Example

User interface element

When referring to labels and names
in the user interface.

User input

When the user has to type specific
data in IGSS

The Data Management tab.

Type the following description:

Incoming flow in Tank 2

Module
name

When referring to a module in IGSS

Note

A note emphasizes or supplements
important points of the main text. A
note provides information that may
apply only in special cases.

Tip

A tip suggests alternative methods
that may not be obvious in the user
interface. A tip also helps the user in
working more effectively with IGSS.
A tip is not essential to the basic
understanding of the text.

Alternative to this simple find
function, you can also filter on
text in the messages in Driver
Log Filters dialog box.

Warning

A warning is an important note that is
essential for the completion of a
task. In some cases, disregarding a
warning may result in undesirable
functionality or loss of data.

If you disregard the System
alarm, you may risk loss of
data in the LOG and BCL files.

Open the Definition module.

By default, the timestamp is in universal time
format, UTC1. This can be changed in the
Driver Log Filters dialog box.

5.2 Getting Help in IGSS
IGSS comes with a comprehensive help system designed to help both system designers and operators to
get started with IGSS as quickly as possible.

Documentation overview
The IGSS documentation includes the following items:

1 Universal Time Coordinated (formerly Greenwich Mean Time), used as the basis for calculating time in

most parts of the world. IGSS uses this time format internally in the database. You can switch between UTC
and local time by enabling or disabling the "UTC" field in various dialog boxes in the system.
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Documentation item

Description

Getting Started

An introduction to IGSS and its most fundamental terms and features.
Getting Started is intended to get you up and running as fast as possible. The manual provides a system and architecture overview followed by a number of real-life use cases you can go through before
building your first real IGSS project. The manual is available in Adobe
Acrobat format (.pdf).
For each module there is a help file with the same name as the module
itself, for example, Def.chm for the Definition module.

Module help

The help file is invoked by clicking the
in the upper right corner of
the module. The Table of Contents will then allow you to browse
through the topics.
For each Form or dialog there is a help topic with the following standard information:

Form and Dialog help

l

Overview

l

Preconditions

l

Where do I find it?

l

Field help

Form help is invoked by clicking the help button
in the upper right
hand corner of the dialog box or located in the Table of Contents of the
individual help file.
IGSS also provides thematic help. When there is a special theme that
requires special attention from the user, a dedicated help file is provided. Examples include "Driver-Specific Help" and "Database Administration Help".

Thematic help

Where are the help files located?
The IGSS help files are located in the appropriate language folder in the installation path of IGSS, by
default C:\Program Files\Schneider Electric\IGSS32\V10.0. The help files are available in English at
release time.
The paths to the help files are:

Language

Path

English

[IGSS InstallPath]\ENG

Danish

[IGSS InstallPath]\DAN

German

[IGSS InstallPath]\DEU

Translated help files
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Selected help files have been translated into Danish and German. If you require help files in your language,
please contact 7-Technologies A/S.

Help updates
The help files are continuously updated and improved. Check regularly with the IGSS Update in the IGSS
Master.

5.3 Version Information (IGSS Help System)
© 7-Technologies A/S, IGSS Version 10.0
The IGSS help files are based on software build number 10305 (initial release)

English help files
To update the help files, click the Update IGSS Software button on the Information and Support tab
in the IGSS Master . There must be a connection from the PC to the Internet. Every time IGSS Update is
run, IGSS help files as well as IGSS system files will automatically be updated on the PC from the web
server at 7-Technologies A/S.
You select the languages you want to update in the Tools menu of the IGSS Update form.
If you are not able to update the IGSS system directly via the Internet, the alternative is to download the
updates from the 7-Technologies A/S website as zip files. These can then be transferred onto a CD or USB
memory stick, which is then the medium used to update on site.

After updating your IGSS installation , the build numbers in various IGSS modules may change to a
higher number. This signifies that the module in question has been updated with newer files. Build
numbers consist of four digits, where the first digit represents the year and the last three represent
the day number in the year in question. The build number can be seen in the About dialog box which
can be activated from the Help menu.
An example:

Build number = 10305
12 = the year 2012
305 = The 305th day of the year
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Chapter 6: Glossary
A
Application menu
The Application menu is the first ribbon in the IGSS Master module. Click the icon to drop down
the menu. The menu contains items that were typically found in the File menu in previous versions of IGSS. In most modules, an "Options" item allows the user to define global module settings. The Application menu was introduced in the Microsoft Office 2010 package. It replaces the
Application button (nicknamed Doughnut) which was introduced in IGSS V7 and V8.

D
descriptor
A descriptor is the graphical display of an object. IGSS includes many types of descriptors including: - Built-in standard symbols - Animated symbols (Symbol Factory library) - Graphics and
animation - Drawing symbols - Windows controls - ActiveX controls An IGSS object can be represented with different descriptors on different diagrams.

Q
Quick Access Bar
You can customize the Quick Access Bar to include the functions you use most frequently. Simply
drag the relevant function from the ribbon to the Quick Access Bar.

R
Ribbon
The Ribbon is a new term/element in the Microsoft universe. The Ribbon replaces the well-known
toolbars in applications. The Ribbon provides quick access to the most commonly used functions
in the application. The Ribbon is divided into logical groups (the tabs) and each tab is divided into
sections (the blocks in the tab). The Ribbon is context-sensitive which means that only relevant
functions are accessible dependent on the current user action.

S
SCADA
Supervisory Control & Data Acquisition

U
UTC
Universal Time Coordinated (formerly Greenwich Mean Time), used as the basis for calculating
time in most parts of the world. IGSS uses this time format internally in the database. You can
switch between UTC and local time by enabling or disabling the "UTC" field in various dialog boxes
in the system.
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